
GETTING STARTED

Accucadd Software

Accucadd software, including the Evaluation version, is freely copyable. You are

recommended to make a back-up copy of the compact disk (CD) before using it for

the first time. Store the original Accucadd CD in a safe place, in case it is needed

again - which will not occur unless the working copy becomes corrupted.

A WORD ON COMPACT DISKS (CD) ...

In general, CD are reliable and durable. You can help keep them that way by careful

handling:

� Handle only by the center hole and extreme edges.

� Never touch the main surface of the disk itself.

� Keep diskettes away from dust, grit, smoke, and anything else likely to
contaminate the surface.

� Return disk to its protective case or sleeve when not in use.

� Keep CD away from heat and liquids.

� Keep in mind that the one time you get careless is the time you lose a
few bytes from a critical folder, destroying hours of creative work.

A WORD ON WINDOWS ...

Accucadd, like most other programs running on your computer, makes use of

Microsoft Windows. Windows is the computer’s housekeeper, the essential

interface between the computer hardware, applications software, and data files

stored on your disk drive.

Commercial applications programs, Accucadd included, go to some lengths to

conceal the computer’s inner workings, and you can use them without knowing the

first thing about Windows. However, mastery of basic Windows operations, such as
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disk formatting and file copying, can give you a great deal of independence. The

User’s Help included with Windows is a good introduction. Several Windows

primers are also available from your local bookstore.

Throughout the tutorial, the square brackets [] signify an action or procedure

you should try for yourself.

When you first receive Accucadd you will need to install the software. Simply insert

the CD in your CD drive. The installation program will usually start to run

automatically within a few seconds. If this does not happen, you can use Start:

Settings: Control Panel: Add/Remove Programs, or you can use Start: Run...

Browse to your CD drive, and then run the installation program (setup.exe), or you

can do the same thing in Windows Explorer. If this is a first time installation, accept

the installation program’s suggested settings. If this is not a first time installation, be

sure you have backed up your library before proceding to ensure that the new

extended library does not overwrite any work you wish to keep.

The following assumes a configured, operational system, with Accucadd installed in

the suggested folder C:\Program Files\Accucadd.

Running Accucadd

You will have one or more of the following ways to start Accucadd:

• A “shortcut” to Accucadd on your Desktop - double-click to run Accucadd

• An entry for Accucadd in your Start Menu - click to run Accucadd

• An entry for Accucadd in the Start: Programs Menu - click to run Accucadd

• Or, you can browse to the folder C:\Program Files\Accucadd and double-click

Accucadd(.exe)

When the Accucadd files have been read from the hard disk, you will be asked if you

want to load the previous drawing–click “No”. The blank work area appears as

shown below. Your Accucadd system is now ready for use.
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MAKING MENU SELECTIONS

The main menu titles, such as Set Up and Draw, run along the top of the screen. The

palettes at right contain icons depicting various types of drawing element, line type

and line weight. The cursor is a + marker (not shown below).

[] The cursor follows movements of the mouse (or digitizer stylus).

To select an item from a menu or palette, simply point-and-click–push the left-hand

mouse button. (With a digitizer tablet, you “click” by gently pushing down on the

stylus, or (in most cases) any of the buttons on the puck.)

To cancel a menu selection, press the Esc (escape) key, or simply make another

selection. The right-hand mouse button (or a second button on a digitizer puck) can

usually be used to cancel menu selections, too.

Throughout this tutorial, the word “touch” means “point-click left button”
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[] Touch Set Up on the main menu. This displays the Set Up menu as shown below.

Note that the + cursor changes to a pointer when in menu territory.

[] Touch Paper on the Set Up menu. A “pop-up

window” appears, inviting you to select from a

number of different paper sizes. This sets the “size”

of the “piece of paper” that you are drawing on. For

now, simply press the Esc key to exit the function.

If you move the mouse too quickly you may find you

are getting the “wrong” menu entry. This is

because Windows looks at the menu entry under

the cursor when you release the button, not when

you press it. Make sure the cursor is still over the

selection you want when you release the button. If

the Orth Trap is not displayed on your screen, move the cursor to the Toolkit menu

and touch Orth Trap. Additionally, make sure the elements palette is displayed and

line is selected as shown in above. The Elements palette is displayed if you touch

the Elements command in the Draw menu.

The dotted lines passing through the screen center belong to the Orth (ogonal) trap,

which was pre-selected for you from the Toolkit menu. Away from the trap lines, the

cursor moves freely about the screen. Close to a trap line, the cursor seems to fall

into a groove, and now prefers to move only along the line. We use this feature to

draw precise horizontal and vertical lines.

[] Move the + cursor to the screen center; when approaching the center, it snaps

into position, as though magnetized. Now touch the center point to “plant” the

cursor, marking the start of a line.

The cursor is now tethered to the datum by a “rubberband”, which shows you how

the line will appear when you confirm it. This visual feedback of length and position

allows you to experiment freely, without actually drawing the line.

[] Keep an eye on the dimension display at the bottom of the screen, move the +

cursor vertically up from the triangle about 3 in., then “touch” to draw line (1), as in

Figure 3.

To draw line (2), we need to shift the datum to the top of line (1). This is very easy with

Accucadd, because end-points are automatically snap points (“magnetic points”)

unless you choose otherwise.
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Figure 2: Set Up menu



[] Snap the + cursor to the top end of line (1), then touch to set the new datum

there. Notice that the Orth Trap has “updated” (moved to the new datum).

[] Move the + cursor about 4" to the right, along the trap line, then touch to draw

line (2) to make an L-shaped figure.

Our next “data entry” - the line we are about to add - turns the “L” into a triangle, but

before that, you might try turning off the Orth Trap. You don’t have to do this (some

users leave it on most of the time), but it’s a good idea to practice.

[] Touch the word Orth (below Toolkit) to cancel the trap. This may leave holes in

the lines you drew. This is only a display effect, having no affect on the quality of

printed hard copy. you can repair the image by selecting Redraw from the VIEW

menu.

[] Move the cursor to the free end of one of the two lines; again, as you approach

the target, the cursor snaps precisely into position. Plant the cursor there (touch),

then head for the other line-end. Snap the cursor there, then touch to draw line

(3), as in Figure 4.

Use the Esc key to free the cursor, if you find you’ve planted it in the wrong place.

Esc, repeated as necessary, can get you out of most situations or procedures you

don’t like the look of. If in trouble, think Escape.

A FEW WORDS ON DISPLAY RESOLUTION...

In the context of CAD, this means the ability to display detail. Your video display is a

mosaic of thousands of tiny cells, called pixels, which are individually controlled by

the computer’s display processor, or “graphics card”. The more pixels per square

inch, the better the resolution. With a common setting, your display has 800 pixels

horizontally, and 600 vertically. Looking closely, you will see that orthogonal lines

(true horizontal and vertical) display perfectly, whereas all other lines - and arcs - are

uneven, or jagged. This is strictly a display effect, having nothing to do with the

accuracy or quality of the drawing, as you will see from the printed examples later.
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You’ve seen how Orth helps make a neat job of freehand sketching, with true

horizontal and vertical lines. It can also be used with numerical data entry, from the

keyboard, to draw lines precisely to length.

[] Turn on the Orth trap, by touching the word Orth again. Touch any point (4) on

the work area, as Figure 5, to set the start (datum) of a new line there.

With numerical data entry, you simply point the way, then let the system decide how

far to go.

[] Move the + cursor left along the trap line, then key in 3.1875 followed by Enter

to draw the line to the exact length.

You will have noticed that the first number key pressed brings up a “window”

displaying whatever you key in. This applies to all actions where numerical data

entry is required or optional.
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[] Touch the left end of the horizontal line. Point the cursor down the trap line,

then key in 2.5625 followed by Enter.

DRAWING PRECISION...

We have been working to four decimal places, but you may enter more digits if you

wish. However, drawing with greater precision than the job needs is a waste of time.

What you are aiming for in most cases is a representational drawing, serving the

same purpose as those “hand drawings” in days gone by (and how precise,

physically, were they?). In such a drawing, the dimension labels are more important

than physical appearance. You will need to pay more attention to precision if your

drawing is to be an actual dimensional reference, for example, in architecture, or

direct control of machine tools (CNC). Regardless of what you set the displayed

precision to, Accucadd works to better than 16 digit precision internally.
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[] Draw a line 3.1875" to the right, then complete the rectangle, as Figure 6, using

“magnetic points”. Just touch one line-end, and then the other.

Since magnetic points are so useful, most users leave them active at all times.

Occasionally, you may wish to deactivate them:

[] Unless you removed it by accident, the Points palette should be displayed at

bottom left of the screen. To “demagnetize”, click the top icon (point and click). To

“magnetize”, click it again. If the palette is missing, retrieve it by selecting Points

from the Toolkit menu.

Within the drawing area, snap points and handles are denoted, respectively, by tiny

rectangles and triangles. You can reduce clutter by turning off the symbols, which

you don’t need most of the time.
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Figure 5: Drawing precisely to length
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[] Click the “points displayed” icon on the Points palette. This is the second icon

from the top of the Points palette. Although the markers have disappeared, the

end-points are still magnetic “snaps”.

A third icon on the Points palette is used to locate intersections. This function is

described in a later example. Two more icons on the Points palette represent the

“midpoint find” and “update snaps” functions. Refer to the Accucadd Reference

Manual for additional details.

Throughout Accucadd, a “pushed-in” button means “YES / GO / ACTIVE”, and a

“released” button means “NO / STOP / INACTIVE”. Active selections are also

highlighted in yellow.

EDITING THE DRAWING

So far, we have used Esc to give us a second shot if we planted the cursor in the

wrong place; in fact, you can use Esc to break any action sequence, such as keying

in numerical data. However, once you have committed yourself by drawing

something, it’s too late for Esc; now, you need to edit the drawing:

[] Steer the cursor to any corner of the drawing. Snap it into place, then draw a

line - any line - from there to some other point on the screen (arrowed in Figure 6).

[] Select the Edit menu, as in Figure 6. Select Undo, and the line disappears.

You could have used Erase instead, but Undo is the faster way of removing the last

line drawn. (Undo actually does more than remove the last entry; it restores the

system controls to their previous condition.) Erase lets you remove any line,

regardless of when it was drawn.

[] Draw another “unwanted” line, just like the one you “undid”.

[] Select the EDIT menu, then select Erase.

Examine the Erase palette shown in Figure 7. There are several element selection

methods. Select whole item, as shown. Make sure that visible tagging is also

selected. These same selection techniques are used for the Change, Move, and

Copy commands. Make sure you are using whole item with visible tagging as in

Figure 7.
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Steer the rectangular “whole item” cursor over the element to be removed, then

touch to confirm. The line is tagged with end markers and a cross. Tag more lines if

you wish.

If you change your mind, and don’t want to remove that line, trap it again (touch) to

remove the markers. This procedure is called “de-selection”; it also applies to other

functions on the Edit menu, such as Change.

[] Remove the line by touching the large check on the Erase palette. Exit the

Erase function by touching the “cancel” symbol, [C]. Touching [C] before the

large check mark will exit Erase without making any changes.

Throughout Accucadd, [C] means “cancel”, or “abort”
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Figure 6: Modifying the drawing using Edit functions



HOW TO CLEAR THE SCREEN IN ONE GO...

Edit: Wipe will clear your drawing. You can not Undo a Wipe, so you will always be

asked to confirm.

Wipe permanently removes all elements of your drawing, without affecting the

system controls (Paper size, units, scale, and so on).

PAPER SIZE, UNITS AND SCREEN DIMENSIONS
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Newcomers to CAD are often perplexed by the relationship of “real- life” dimensions

and screen image size. When we ask you to draw a 4" square, that’s exactly what the

CAD system records internally. However, only by pure chance will its screen image

measure 4", because this depends on uncontrolled variables such as monitor size,

and the scale factor you specified. The other point to ponder is the size of the printed

drawing. In most CAD work, you will want the print itself to be an exact measure of

the object depicted - scaled up or down, of course, depending on the application,

and size of printer paper chosen. Accucadd keeps all these variables under control

in a unique way.

First you choose Units, which can be any popular English or Metric selection. Next, you

choose one of 14 ANSI or ISO Paper Sizes (or specify one of your own). This redraws

the work area on the screen to match. Your choice of paper size is reported at right of

the “status line” along the bottom of the screen. Finally, you choose a Scale to fit the

object you wish to draw within the paper boundary; for example, a scale of 1:10 would

allow you to draw a figure 100" wide on an A-size sheet (11 x 8-1/2).

“What you see is what you get”

With Accucadd, as you develop your drawing, you can see at a glance how it will

print on the chosen size of paper; this is because the ratio of print-to-paper is exactly

the same as screen image-to-work area.

Q: I have an A-size printer; suppose I started out with a scale of 1:10, giving me a

100" wide work area, and it turns out I need 150" ?

A: Change the scale to 1:20 (or a scale of your choice). You could select a larger

paper size (B-size, 11 x 17, would do), but since your printer can’t handle it, you will

not have “what-you-see-is-what-you-get” operation. Whichever you choose, the

screen image will be redrawn (smaller) in correct proportion to the new work area,

but the object’s real dimensions do not change. These are absolute values, tablets

of stone! 100" is still 100" to the CAD system, even though the display is half its

original size.

[] Wipe the screen, then sketch any simple figure to fill the A-size work area, as

shown in Figure 8.

[] Select Paper Size from the Set Up menu and select C. The status line now reports

22 x 17, and the aspect ratio (width: height) of the work area has altered accordingly,

as in Figure 9.
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[] Return to A-size paper, then select Scale from the Set Up menu. Key in 1:2,

then press Enter. The status line reports the new scale, and image is redrawn at

half size.
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Figure 9: Larger paper size, smaller image

Figure 8: Draw any figure to fill the work area



METRIC AND ENGLISH UNITS

You can experiment with the various units available in Accucadd:

[] Select Units from the SET UP menu (or from the status line).

The table now displayed lists two classes of units, “specific” and “generic”. The

specific units are mm, m, km, 1/64", inches, feet (‘), and miles. Selection of one of

these forces the system to work only in that specific unit, and decimal fractions of it

(except 1/64", which works in inches to the nearest 1/64). The generic modes,

ENGLISH and METRIC, allow the system to choose the most appropriate form of

display and data entry. For example, in the ENGLISH mode, a length 12" or greater

will display as feet, inches, and fractional inches:

[] Select Paper Size, then D; now select Units, ENGLISH.

[] Touch any point (set datum) near the left edge of the work area, then move

away to the right.

You will see that the dimensions display reports in inches and fractions of an inch up

to 12, then converts to feet, inches and fractions. The “size” of the fraction is set by

the Set Up: Precision menu. It can range from whole inches (no fractions) to

1/64inch. Now try entering a line length using the same convention:

[] From any datum point near the edge, give the rubberbanded line a direction by

pointing it toward the center, then key in:

[2][‘][3][SPACE][31][/][64][ENTER].

(SPACE means “press space bar”). This will draw a 2’- 3 31/64" line, in the

chosen direction.
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